	PHÒNG GD&ĐT QUẬN LONG BIÊN

TRƯỜNG THCS NGÔ GIA TỰ
	MA TRẬN ĐỀ KIỂM TRA HỌC KÌ II
                 Môn : Tin học 6 
                Năm học: 2017 – 2018



I. Mục tiêu:  
1. Kiến thức:

Kiểm tra đánh giá kiến thức học sinh qua các chương, chủ đề dạy học ở Học kì II.

· Làm quen với soạn thảo văn bản.
· Chỉnh sửa và định dạng văn bản, đoạn văn bản.
· Tìm kiếm và thay thế.

· Chèn hình ảnh minh họa.
· Tạo bảng.
2. Kĩ năng:

· Có kĩ năng soạn thảo và chỉnh sửa văn bản.
· Thành thạo trong việc chèn hình ảnh, tạo bảng.
3. Thái độ:

Rèn tính cẩn thận, khả năng phân tích và tính trung thực trong thi cử của học sinh.
4. Định hướng phát triển năng lực:

Năng lực tự học,tự giải quyết vấn đề,tư duy sáng tạo,logic,….
II. Yêu cầu:
· Ý thøc: KiÓm tra nghiêm túc, đúng quy chế thi.
· H×nh thức: KiÓm tra trªn giÊy.
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 ĐỀ 1
I/ TRẮC NGHIỆM (4 điểm). 
           Hãy ghi lại các chữ cái đứng trước câu trả lời đúng.
Câu 1: Muốn khởi động chương trình soạn thảo văn bản Word, em nháy đúp chuột vào biểu tượng nào dưới đây trên màn hình nền?

A. [image: image1.png]


          
 
B. [image: image2.png]=



       


 C.  [image: image3.png]


 


D. [image: image4.png]



Câu 2 : Để mở 1 trang văn bản mới trên máy tính, em chọn cách nào?:

A. Ctrl + S

B. Ctrl + N

C. File ( open

D. File ( New

Câu 3: Trong định dạng kí tự nút lệnh nào sau đây để định dạng kiểu chữ in đậm? 

A.  [image: image5.png]






B.   [image: image6.png]





C.  [image: image7.png]





D.  [image: image8.png]



Câu 4: Để trình bày trang văn bản em chọn lệnh:
A. File ( Save ...





B. File ( Open ... 



C. Edit (Replace ... 




D. File (Page Setup… 

Câu 5: Để xóa các hàng em sử dụng lệnh:  

A. Table ( Delete ( Rows. 



B. Table ( Delete ( Columns. 

C. Table ( Delete ( Table.  



D. Table ( Insert( Table.

Câu 6: Để phục hồi trạng thái của văn bản trước đó, ta dùng nút lệnh:
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Câu 7: Để mở tệp văn bản đã được lưu trên máy tính, em sử dụng nút lệnh:
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Câu 8: Theo thứ tự từ trái qua phải, ý nghĩa của các biểu tượng [image: image17.png]


 là:

A. Căn lề trái,  căn lề giữa,  căn lề hai bên,  căn lề phải

B. Căn lề phải,  căn lề trái,  căn lề giữa,  căn lề hai bên

C. Căn lề trái,  căn lề giữa,  căn lề phải,  căn lề hai bên

D. Căn lề phải,  căn lề trái,  căn lề đều hai bên,  căn lề giữa
II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Nêu các bước để sao chép một phần văn bản đã có vào một vị trí khác.
Câu 2 (2đ). Nêu các bước cơ bản để chèn hình ảnh từ một tệp đồ họa vào văn bản.

Câu 3 (2đ). Nêu mục đích của việc trình bày nội dung văn bản bằng bảng.  
Chúc các con làm bài tốt !
                                      ĐÁP ÁN VÀ THANG ĐIỂM

I/ TRẮC NGHIỆM  (4 điểm). 

Mỗi câu đúng cho 0,5đ 

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	B
	B-C
	A
	D
	A
	B
	C
	C


II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Các bước để sao chép một phần văn bản đã có vào một vị trí khác:

Bước 1: Chọn phần văn bản muốn sao chép và nháy nút Copy
   
 (1đ)

Bước 2: Đưa con trỏ soạn thảo tới vị trí cần sao chép và nháy nút Paste

 (1đ)

Câu 2 (2đ). Các bước cơ bản để chèn hình ảnh từ một tệp đồ họa vào văn bản.
Bước 1: Đưa con trỏ soạn thảo tới vị trí cần chèn hình ảnh

 (0,5đ)

Bước 2: Chọn lệnh Insert -> Picture -> From File … Hộp thoại Insert Picture xuất hiện 

 (1đ)

Bước 3: Chọn tệp đồ họa cần thiết và nháy Insert

 (0,5đ)

Câu 3 (2đ) 

HS nêu được mục đích của việc trình bày văn bản bằng bảng: Cô đọng, dễ hiểu và dễ so sánh. 













      
(2đ)

	NGƯỜI RA ĐỀ

Nguyễn Văn An
	TỔ TRƯỞNG CM

Phạm Anh Tú
	KT HIỆU TRƯỞNG

PHÓ HIỆU TRƯỞNG

Nguyễn Thị Song Đăng
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ĐỀ 2

I/ TRẮC NGHIỆM (4 điểm). 

          Hãy ghi lại các chữ cái đứng trước câu trả lời đúng .

Câu 1: Trong phần mềm soạn thảo Word, để tạo bảng  em chọn nút lệnh nào sau đây trên thanh công cụ  chuẩn? 
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B. [image: image19.png]


 


C. [image: image20.png]


  
 
D. [image: image21.png]



Câu 2: Theo thứ tự từ trái qua phải, ý nghĩa của các biểu tượng [image: image22.png]


 là:

A. Căn lề trái,  căn lề giữa,  căn lề hai bên,  căn lề phải

B. Căn lề phải,  căn lề trái,  căn lề giữa,  căn lề hai bên

C. Căn lề trái,  căn lề giữa,  căn lề phải,  căn lề hai bên

D. Căn lề phải,  căn lề trái,  căn lề đều hai bên,  căn lề giữa

Câu 3:Câu 2 : Để mở 1 trang văn bản mới trên máy tính, em chọn cách nào?:

A. Ctrl + S

B. Ctrl + N

C. File ( open

D. File ( New  
Câu 4: Muốn khởi động chương trình soạn thảo văn bản Word, em nháy đúp chuột vào biểu tượng nào dưới đây trên màn hình nền?

A. [image: image23.png]


          
 
B. [image: image24.png]=



       


 C.  [image: image25.png]


 


D. [image: image26.png]



Câu  5: Để mở tệp văn bản đã được lưu trên máy tính, em sử dụng nút lệnh:
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B. [image: image28.png]
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Câu 6: Để xóa các cột em sử dụng lệnh: 

A. Table ( Delete ( Rows. 



B. Table ( Delete ( Columns. 

C. Table ( Delete ( Table.  



D. Table ( Insert( Table.

Câu 7: Để trình bày trang văn bản em chọn lệnh:

A. File (Page Setup…




B. File ( Open ... 



C. Edit (Replace ... 




D. File ( Save ...
Câu 8: Trong định dạng kí tự nút lệnh nào sau đây để định dạng kiểu chữ in nghiêng? 

A.  [image: image31.png]
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II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Nêu các bước để di chuyển một phần văn bản đã có vào một vị trí khác.

Câu 2 (2đ). Nêu mục đích của việc trình bày nội dung văn bản bằng bảng.  

Câu 3 (2đ). Nêu các bước cơ bản để chèn hình ảnh từ một tệp đồ họa vào văn bản.

Chúc các con làm bài tốt !

ĐÁP ÁN VÀ THANG ĐIỂM
I/ TRẮC NGHIỆM (4 điểm). 

Mỗi câu đúng cho 0,5đ 

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	C
	C
	B-C
	B
	D
	B
	A
	B


II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Các bước để di chuyển một phần văn bản đã có vào một vị trí khác:

Bước 1: Chọn phần văn bản muốn di chuyển và nháy nút Cut
   
     (1đ)

Bước 2: Đưa con trỏ soạn thảo tới vị trí cần di chuyển tới và nháy nút Paste

     (1đ)

Câu 2 (2đ). 

HS nêu được mục đích của việc trình bày văn bản bằng bảng: Cô đọng, dễ hiểu và dễ so sánh.                                   (2đ)

Câu 3 (2đ). Các bước cơ bản để chèn hình ảnh từ một tệp đồ họa vào văn bản.
Bước 1: Đưa con trỏ soạn thảo tới vị trí cần chèn hình ảnh

    (0,5đ)

Bước 2: Chọn lệnh Insert -> Picture -> From File … Hộp thoại Insert Picture xuất hiện 

    (1đ)

Bước 3: Chọn tệp đồ họa cần thiết và nháy Insert

    (0,5đ)

	NGƯỜI RA ĐỀ

Nguyễn Văn An
	TỔ TRƯỞNG CM

Phạm Anh Tú
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TRƯỜNG THCS NGÔ GIA TỰ
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                Năm học 2017 – 2018
                Thời gian: 45 phút


ĐỀ 3

I/ TRẮC NGHIỆM  (4 điểm). 

   Hãy ghi lại các chữ cái đứng trước câu trả lời đúng .                  
Câu 1: Để kết thúc soạn thảo ta nháy nút nào sau đây ở trên cùng bên phải cửa sổ của Word?

A. [image: image35.png]




 
B. [image: image36.png]




   
C. [image: image37.png]





D [image: image38.png]



Câu 2: Theo kiểu gõ TELEX thì chữ Toán học được gõ như thế nào?

     
A. Toans hojc               B. Toán học          C. Toasn hocj               D. Tosan hocj
Câu 3: Trong định dạng đoạn văn nút lệnh  nào sau đây trên thanh công cụ của cửa sổ Word để căn thẳng lề trái?

A. [image: image39.png]





B. [image: image40.png]





C.  [image: image41.png]





D. [image: image42.png]



Câu 4: Muốn khởi động chương trình soạn thảo văn bản Word, em nháy đúp chuột vào biểu tượng nào dưới đây trên màn hình nền?

A. [image: image43.png]


          
 B. [image: image44.png]=



       

C.  [image: image45.png]


 

D. [image: image46.png]



Câu 5: Để trình bày trang văn bản em chọn lệnh:

A. File ( Save ...





B. File ( Open ... 



C. Edit (Replace ... 




D. File (Page Setup… 

Câu 6: Trong phần mềm soạn thảo Word, để tạo bảng  em chọn nút lệnh nào sau đây trên thanh công cụ  chuẩn? 
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B. [image: image48.png]





C. [image: image49.png]



 

D. [image: image50.png]



Câu  7: Nút lệnh để xem trước khi in là:
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B. [image: image52.png]





C. [image: image53.png]
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    dùng để:
A. Tăng mức thụt lề trái 


B. Giảm mức thụt lề trái

C. Căn khoảng cách giữa các dòng trong đoạn văn.
D. Căn khoảng cách giữa các đoạn văn.

II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Nêu sự giống nhau và khác nhau về chức năng của phím Delete và phím Backspace trong soạn thảo văn bản.

Câu 2 (2đ). Nêu các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản.

Câu 3 (2đ). Nêu các bước để tạo bảng trong văn bản.

Chúc các con làm bài tốt !

ĐÁP ÁN VÀ THANG ĐIỂM
I/ TRẮC NGHIỆM KHÁCH QUAN (4 điểm). 

Mỗi câu đúng cho 0,5đ 

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	A
	A-C
	A
	B
	D
	C
	C
	B


II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). 

Nêu sự giống nhau về chức năng của phím Delete và phím Backspace đúng 

(1đ)

Nêu sự khác nhau về chức năng của phím Delete và phím Backspace đúng. 


(1đ)

Câu 2 (2đ). Các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản:

Bước 1: Nháy chuột trên hình để chọn hình ảnh đó





(0,5đ)

Bước 2: Chọn lệnh Format -> Picture … xuất hiện hộp thoại




(1đ)

Bước 3: Chọn in line with text (Nằm trên dòng văn bản) hoặc Square (Nằm trên nền văn bản) và nháy Ok











(0,5đ)

Câu 3 (2đ). Nêu các bước để tạo bảng trong văn bản.

Bước 1: Chọn nút lệnh Insert Table trên thanh công cụ chuẩn




(1đ)

Bước 2: Nhấn giữ nút trái chuột và di chuyển chuột để chọn số hàng, số cột cho bảng rồi thả nút chuột












(1đ)
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Phạm Anh Tú
	KT HIỆU TRƯỞNG

PHÓ HIỆU TRƯỞNG

Nguyễn Thị Song Đăng


	PHÒNG GD&ĐT QUẬN LONG BIÊN

TRƯỜNG THCS NGÔ GIA TỰ
	ĐỀ KIỂM TRA HỌC KÌ II TIN HỌC 6
                Năm học 2017 – 2018
                Thời gian: 45 phút


ĐỀ 4

I/ TRẮC NGHIỆM  (4 điểm).
           Hãy ghi lại các chữ cái đứng trước câu trả lời đúng.
Câu 1: Nút lệnh    [image: image56.png]T BE Kt 1 TIET Thé- hk 2 - Microsoft Word
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Cau14: Trinh ty hp 1i nhét khi soan thao van ban la: )
A, G5 vin bén, trinh bay, chinh sira, in4n B, Chinh sita, trinh bay, g5 vin ban, in in
€. G5 van bén, chinh sira, trinh bay, inén  D. G vin bén, trinh bay, in &n, chinh sra
- Céu 15: Tgp tin clia phin mém sogn thio van ban c6 phin mé réng ngém dinh la:
B Axls B.txt Cexe D.doc
B Cau 16: D8 dinh dang ki ty trong van bn, ta sit dung hip thogi:
o A Save as B.Font €. Paragraph D. Page Setup
B Cau17: Dé dinh dang dogn van ban, ta si dyng hip thoai:
i A Save as B. Font C.Paragraph D. Page Setup
M C4u 18: Sip xép cac thanh phin trong van bin tir nhé dén 1on theo thir t
H A Kitw, ciu, bit, doan vin bin; B. Tir, ki ty, v, doan vén bin,
§ €. Tir, chu, doan vin bin, ki tir D. Ki b, b, cu, doan vin bin; E
H Céu 19: Theo thit ty ti trai qua phi, ¥ nghia clia cac bifu twgng EE===,
B , cinl gitra, cin &
- B. Can 8 phii, can 18 tréi, cin 18 gitva, can 18 hai bén L]
b €.Con 18trdi, can 18 gitra, cin 12 phai, can 12 hai bén
: D. Can 1 phai, canlé tréi, cin1é déu hai bén, cin 1 gitra
- C4u20: Chirc niing khéng thudc vé soan thao vin bén la:
- A. Thay di kidu chiy B. Cin 1 cho doan vin
€. Dinh dang ki tw D. Qun li téptin
°
i )3
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    dùng để:
A. Tăng mức thụt lề trái 


B. Giảm mức thụt lề trái

C. Căn khoảng cách giữa các dòng trong đoạn văn.
D. Căn khoảng cách giữa các đoạn văn.

Câu 2: Trong định dạng đoạn văn nút lệnh  nào sau đây trên thanh công cụ của cửa sổ Word để căn thẳng lề trái?

A. [image: image57.png]





B. [image: image58.png]






C.  [image: image59.png]





D. [image: image60.png]



Câu 3: Theo kiểu gõ TELEX thì chữ Toán học được gõ như thế nào?

     
A. Toans hojc               B. Toán học          C. Toasn hocj               D. Tosan hocj
Câu 4: Để kết thúc soạn thảo ta nháy nút nào sau đây ở trên cùng bên phải cửa sổ của Word?

A. [image: image61.png]




 
B. [image: image62.png]




   

C. [image: image63.png]





D [image: image64.png]



Câu 5: Để xóa các cột em sử dụng lệnh: 

A. Table ( Delete ( Rows. 



B. Table ( Delete ( Columns. 

C. Table ( Delete ( Table.  



D. Table ( Insert( Table.

Câu 6: Có thể sao chép hình ảnh trong văn bản bằng nút lệnh: 

A.  [image: image65.png]




B.  [image: image66.png]
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D. [image: image68.png]


 

Câu 7: Trong hộp thoại Find and Replace  để thay thế cụm từ tìm được bằng cụm từ thay thế ta nháy nút nào sau đây? 

A.  More

B. Find Next 


C. Cancel

D. Replace 

Câu  8: Nút lệnh để xem trước khi in là:
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B. [image: image70.png]






C. [image: image71.png]
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II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Nêu sự giống nhau và khác nhau về chức năng của phím Delete và phím Backspace trong soạn thảo văn bản.

Câu 2 (2đ). Nêu các bước để tạo bảng trong văn bản.

Câu 3 (2đ). Nêu các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản. 

Chúc các con làm bài tốt !

ĐÁP ÁN VÀ THANG ĐIỂM
I/ TRẮC NGHIỆM (4 điểm). 

Mỗi câu đúng cho 0,5đ 

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	B
	A
	A-C
	A
	B
	A
	D
	C


II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). 

Nêu sự giống nhau về chức năng của phím Delete và phím Backspace đúng 

(1đ)

Nêu sự khác nhau về chức năng của phím Delete và phím Backspace đúng. 


(1đ)

Câu 2 (2đ). Nêu các bước để tạo bảng trong văn bản.

Bước 1: Chọn nút lệnh Insert Table trên thanh công cụ chuẩn




(1đ)

Bước 2: Nhấn giữ nút trái chuột và di chuyển chuột để chọn số hàng, số cột cho bảng rồi thả nút chuột












(1đ)

Câu 3 (2đ). Các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản:

Bước 1: Nháy chuột trên hình để chọn hình ảnh đó





(0,5đ)

Bước 2: Chọn lệnh Format -> Picture … xuất hiện hộp thoại




(1đ)

Bước 3: Chọn In line with text (Nằm trên dòng văn bản) hoặc Square (Nằm trên nền văn bản) và nháy Ok











(0,5đ)

	NGƯỜI RA ĐỀ

Nguyễn Văn An
	TỔ TRƯỞNG CM

Phạm Anh Tú
	KT HIỆU TRƯỞNG

PHÓ HIỆU TRƯỞNG

Nguyễn Thị Song Đăng


	PHÒNG GD&ĐT QUẬN LONG BIÊN
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                Năm học 2017 – 2018
                Thời gian: 45 phút


ĐỀ 5

I/ TRẮC NGHIỆM  (4 điểm). 

           Hãy ghi lại các chữ cái đứng trước câu trả lời đúng.

Câu  1: Nút lệnh để xem trước khi in là:
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B. [image: image74.png]






C. [image: image75.png]
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Câu 2: Trong hộp thoại Find and Replace  để thay thế cụm từ tìm được bằng cụm từ thay thế ta nháy nút nào sau đây? 

A.  More

B. Find Next 


C. Cancel

D. Replace 

Câu 3: Có thể sao chép hình ảnh trong văn bản bằng nút lệnh: 

A.  [image: image77.png]




B.  [image: image78.png]
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D. [image: image80.png]


 

Câu 4: Để xóa các cột em sử dụng lệnh: 

A. Table ( Delete ( Rows. 



B. Table ( Delete ( Columns. 

C. Table ( Delete ( Table.  



D. Table ( Insert( Table.

Câu 5: Để kết thúc soạn thảo ta nháy nút nào sau đây ở trên cùng bên phải cửa sổ của Word?

A. [image: image81.png]




 
B. [image: image82.png]




   

C. [image: image83.png]





D [image: image84.png]



Câu 6: Theo kiểu gõ TELEX thì chữ Toán học được gõ như thế nào?

     
A. Toans hojc               B. Toán học          C. Toasn hocj               D. Tosan hocj
Câu 7: Trong định dạng đoạn văn nút lệnh  nào sau đây trên thanh công cụ của cửa sổ Word để căn thẳng lề trái?

A. [image: image85.png]





B. [image: image86.png]






C.  [image: image87.png]





D. [image: image88.png]
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- Céu 15: Tgp tin clia phin mém sogn thio van ban c6 phin mé réng ngém dinh la:
B Axls B.txt Cexe D.doc
B Cau 16: D8 dinh dang ki ty trong van bn, ta sit dung hip thogi:
o A Save as B.Font €. Paragraph D. Page Setup
B Cau17: Dé dinh dang dogn van ban, ta si dyng hip thoai:
i A Save as B. Font C.Paragraph D. Page Setup
M C4u 18: Sip xép cac thanh phin trong van bin tir nhé dén 1on theo thir t
H A Kitw, ciu, bit, doan vin bin; B. Tir, ki ty, v, doan vén bin,
§ €. Tir, chu, doan vin bin, ki tir D. Ki b, b, cu, doan vin bin; E
H Céu 19: Theo thit ty ti trai qua phi, ¥ nghia clia cac bifu twgng EE===,
B , cinl gitra, cin &
- B. Can 8 phii, can 18 tréi, cin 18 gitva, can 18 hai bén L]
b €.Con 18trdi, can 18 gitra, cin 12 phai, can 12 hai bén
: D. Can 1 phai, canlé tréi, cin1é déu hai bén, cin 1 gitra
- C4u20: Chirc niing khéng thudc vé soan thao vin bén la:
- A. Thay di kidu chiy B. Cin 1 cho doan vin
€. Dinh dang ki tw D. Qun li téptin
°
i )3
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    dùng để:
A. Tăng mức thụt lề trái 


B. Giảm mức thụt lề trái

C. Căn khoảng cách giữa các dòng trong đoạn văn.
D. Căn khoảng cách giữa các đoạn văn.

II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). Nêu sự giống nhau và khác nhau về chức năng của phím Delete và phím Backspace trong soạn thảo văn bản.

Câu 2 (2đ). Nêu các bước để tạo bảng trong văn bản.

Câu 3 (2đ). Nêu các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản. 

Chúc các con làm bài tốt !

ĐÁP ÁN VÀ THANG ĐIỂM
I/ TRẮC NGHIỆM  (4 điểm). 

Mỗi câu đúng cho 0,5đ 

	Câu
	1
	2
	3
	4
	5
	6
	7
	8

	Đáp án
	C
	D
	A
	B
	A
	A-C
	A
	B


II. PHAÀN TÖÏ LUAÄN (6 ñiểm)

Câu 1 (2đ). 

Nêu sự giống nhau về chức năng của phím Delete và phím Backspace đúng 

(1đ)

Nêu sự khác nhau về chức năng của phím Delete và phím Backspace đúng. 


(1đ)

Câu 2 (2đ). Nêu các bước để tạo bảng trong văn bản.

Bước 1: Chọn nút lệnh Insert Table trên thanh công cụ chuẩn




(1đ)

Bước 2: Nhấn giữ nút trái chuột và di chuyển chuột để chọn số hàng, số cột cho bảng rồi thả nút chuột












(1đ)

Câu 3 (2đ). Các bước cơ bản để thay đổi bố trí hình ảnh trên trang văn bản:

Bước 1: Nháy chuột trên hình để chọn hình ảnh đó





(0,5đ)

Bước 2: Chọn lệnh Format -> Picture … xuất hiện hộp thoại




(1đ)

Bước 3: Chọn In line with text (Nằm trên dòng văn bản) hoặc Square (Nằm trên nền văn bản) và nháy Ok











(0,5đ)
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